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Safety Precautions

For safe and correct usage
Thoroughly read the “Safety Precautions” and the 
operation manual before using the unit. Keep them 
carefully after reading and use as ready reference.

Pictorial Symbols
The “Safety Precautions” and markings on the product 
contain various pictorial symbols to assure the safety 
use of the product and prevent an injury to you and other 
persons as well as property damage.
As each symbol has the following meanings, thoroughly 
under- stand them before using the unit.
Please note that some precautions may not be applicable to 
the product that you purchased. 

WARNING: Indicates a potentially hazardous situation that 
may arise due to improper handling by taking 
no notice of this symbol and could result in a 
serious injury or death.

CAUTION: Indicates a potentially hazardous situation that may 
arise due to improper handling by taking no notice of 
this symbol and could result in an injury or property 
damage only.

[Note] △ means a heads-up.

Examples of symbols
Symbol “ ” means a prohibited action. The content 
of prohibited matter is mentioned near or in the 
fi gure. (The fi gure on the left side represents “Caution 
for disassembling”.

Symbol “● ” means a mandatory or directive 
content. Practical precautions are shown in the fi gure. 
(The fi gure on the left side represents “Pull out power 
plug from plug outlet.”)  

 Symbol “ ” This mark is a symbol of an operator 
to advise the annex.

 Symbol “ ” This mark is a symbol that represents 
DC

CAUTION
When using the unit:

Do not place a receptacle containing water 
or a small metallic piece on the unit! 
If water spills in the unit, a fi re or electric shock may be  
caused.

Do not use other power supply voltage than 
specifi ed! 
A fi re or electric shock may be caused.

Do not put a metal body or fl ammable 
material into the opening of the unit! 
Do not drop in such material!  
A fi re or electric shock may be caused.

Do not make alterations to the unit!
A fi re or electric shock may be caused.

When installing the unit:
Do not set the unit in an unstable place!  
It may drop or turn down, causing an injury.

Do not connect to any other equipment than 
specifi ed! 
A fi re or electric shock may be caused.

When it is installed, please contact the 
dealer or salesman!
When fi xing the unit, do so in accordance with the specifi ed 
procedure; otherwise it may drop or turn down, causing a 
fi re, electric shock or injury.
Especially when fi xing it to the wall or ceiling, be sure to 
ask the dealer or salesman.

When an abnormal state occurs:
If the unit produces smoke, gives out a foul 
smell or produces an abnormal sound, turn 
off the power switch immediately and pull 
out the power plug!
If the unit is used as it is, a fi re or electric shock may be 
caused. Check that no smoke is produced, and then contact 
the dealer or sales representative.

If water or foreign matter enters the unit, turn off 
the power switch and pull out the power plug!
If the unit is used as it is, a fi re or electric shock may be 
caused. Check that no smoke is produced, and then contact 
the dealer or sales representative.

If the unit is dropped or the case is broken, 
turn off the power switch and pull out the 
power plug!
If the unit is used as it is, a fi re or electric shock may be 
caused. Contact the dealer or sales representative.

If the unit fails to operate properly, turn off 
the power switch and pull out the power plug!
If the unit is used as it is, a fi re or electric shock may be 
caused. Contact the dealer or sales representative.

Do not use any damaged power cord 
(exposed core, broken wire, etc.)! 
If the unit is used as it is, a fi re or electric shock may be 
caused. Contact the dealer or sales representative.
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WARNING
When installing the unit:

Do not place a heavy thing on the unit!
The unit may lose a balance or drop, causing an injury.

Do not get a leg over the unit or carrying case!
Do not sit down on it!
The unit may break down or turn down, causing an injury.

When moving the unit, be sure to turn off the 
power switch, pull out the power plug and 
remove the connecting cable between the 
unit and equipment beforehand.
The cord may be damaged, causing a fi re or electric shock.

When the unit is not used for a long period 
of time, be sure to pull out the power plug 
for safety’s sake.
Otherwise, it may cause a fi re.

Turn off the power switch, to stop working safely, and then 
unplug the power plug.

To avoid the risk of electric shock,this equipment must only 
a supply mains with protective earth.

When installing the unit:
Do not block up the ventilating hole of the unit!
If the ventilating hole of the unit is blocked up, 
heat will accumulate internally, causing a fi re. 
Avoid the following usage:
・Turning up or down the unit. Turning it sideways. 
・Pushing it in ill-ventilated place.
・Placing it on a carpet etc.
・Covering it with a table cloth etc.

Do not place the equipment in the way of diffi cult 
disconnecting the power plug.

Hints on proper usage
When using the unit:
When using the unit in a water-place such as bathroom, 
poolside, etc., prevent water from flowing into the unit 
and cable; otherwise causing an electric shock.
When using it in rainy weather, during snowing, on the seaside or 
waterside, and in a cooking place, use care to prevent such an accident.

When snow comes on, check the surrounding 
conditions before use. Stop using the unit 
temporarily as necessary and do not touch it.
Otherwise causing an electric shock.

Do not connect any equipment whose required 
electric power exceeds the wattage (W) that can be 
supplied from the AC outlet.
Refer to wattage shown near the AC outlet or in the operation manual.

Do not bend (or twist or pull) the power cord and 
connecting cable excessively. 
The covering material of the cord and cable may break, causing an 
electric shock.

When Cleaning the unit:

When before and after each use, dirt can be seen,wipe the dirt/dust off 
the camera using a dry, soft cloth.

When installing the unit:
Avoid installing the unit in a moist place, dusty place 
or any other place exposed to oily smoke and vapor; 
otherwise causing an electric shock.
Do not place the unit near a cooking table or humidifier.

As this unit is heavy (over 10Kg), carry it by 2 or 
more persons.
If it is carried by one person, it may turn down or drop, some- times 
causing an physical damage to the waist or hand or a physical injury.

Take preventive measures against the overturn of the 
unit due to an earthquake or sudden shock.
As the unit may overturn and cause a physical injury, take preventive 
measures against the overturn.

NOTE: This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio 
communication. Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Changes or modifications not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment.

Please classify by the material, and dispose of them according to the law 
and the ordinance etc. of the country and the local government when you 
dispose of the main body and materials for packing.

Instructions for Disposal of Electrical and 
Electronic Equipment in Private Households
Disposal of used Electric and Electronic Equipment 
(Applicable in the European Union and other European 
countries with separated waste disposal and collection 
methods)

This symbol on the product, or in the related document  s in  
the  package, indicates that this product shall not  be treated 
as normal household waste.  Instead, it should  be taken to a 
proper applicable colle ction point  or depot for the recycling 
of electric and electronic equipment. By ensuring this product 

is disposed of correctly, you will help prevent possible negative 
consequences for the environment and  human health, which could 
otherwise be caused by inappropriate waste handling of this product. The 
recycling of materials will help to conserve natural resources. For more 
detailed information about recycling of this product, please contact your 
local city authority, your household waste disposal service or the place 
where you purchased the product.

THE MKC-210HD is authorized EN60601-1 Class I
IP rating of THE MKC-210HD is IPX0.
THE MKC-210HD  is a device for continuous operation.
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Guidance and manufacturer's declaration - electromagnetic emissions
The Model MKC-210HD is intended for use in the electromagnetic environment specifi ed below. The customer or the user 
of the Model MKC-210HD should assure that it is used in such an environment.

Emissions test Compliance Electromagnetic 
RF emissions   CISPR 11

Group 1
The Model MKC-210HD uses RF energy only for its internal 
function. Therefore, its RF emissions are very low and are not likely 
to cause any interference in nearby electronic equipment.

RF emissions   CISPR 11 Class A The Model MKC-210HD is suitable for use in all establishments 
other than domestic and those directly connected to the public 
low-voltage power supply network that supplies buildings used for 
domestic purposes.

Harmonic emissions IEC61000-3-2 Class A
Voltage fl uctuations/fl icker emissions 
IEC61000-3-3 Complies

Immunity test IEC 60601 test level compliance level Electromagnetic environment 
guidance

Electrostatic 
discharge(ESD)
IEC61000-4-2

±6kV contact
±8kV air

±6kV contact 
±8kV air

Floors should be wood, concrete or 
ceramic tile. If fl oors are covered with 
synthetic material, the relative humidity 
should be at least 30%.

Electrical fast 
transient/burst 

IEC61000-4-4

±2kV for power supply lines
±1kV for input/output lines

±2kV for power supply lines
±1kV for input/output lines

Main power quality should be that 
of a typical commercial or hospital 
environment.

Surge
IEC61000-4-5

±1kV differential mode 
±2kV common mode 

±1kV differential mode
±2kV common mode 

Main power quality should be that 
of a typical commercial or hospital 
environment

Voltage dips, short 
interruptions and 
voltage variations on 
power supply input 
lines.

IEC61000-4-11

<5% Ut 
(>95% dip In Ut)
for 0.5 cycle
40% Ut
(60% dip In Ut)
for 5 cycle
70% Ut
(30% dip In Ut)
for 25 cycle
<5% Ut
(>95% dip In Ut)
for 5 cycle

<5% Ut 
(>95% dip In Ut)
for 0.5 cycle
40% Ut
(60% dip In Ut)
for 5 cycle
70% Ut
(30% dip In Ut)
for 25 cycle
<5% Ut
(>95% dip In Ut)
for 5 cycle

Main power quality should be that 
of a typical commercial or hospital 
environment. If the user of the MODEL 
MKC-210HD requires continued 
operation during power mains 
interruptions, It is recommended that 
the MODEL MKC-210HD be powered 
from an uninterruptible power supply 
or battery.

Power frequency 
(50/60 Hz)
magnetic fi eld 
IEC61000-4-8

3 A/m 3 A/m

Power frequency magnetic fi elds 
should be at characteristic of a typical 
location In a typical commercial or 
hospital environment.

NOTE Ut is the a.c.mains voltage prior to application of the test level.
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Guidance and manufacturer's declaration - electromagnetic emissions
The Model MKC-210HD is intended for use in the electromagnetic environment specifi ed below. The customer or the user 
of the Model MKC-210HD should assure that it is used in such an environment.

Immunity test IEC 60601 test level compliance level Electromagnetic environment 
guidance

Conducted RF
IEC61000-4-6

Radiated RF
IEC61000-4-3

3 Vrms
150 kHz to 80 MHz

3 V/m
80 MHz to 2.5 GHz

3Vrms

3V/m

Portable and mobile RF 
communications should be used no 
closer to any part of the MODELMKC-
210HD, Including cables, than the 
recommended separation distance 
calculated from the equation applicable 
to the frequency of the transmitter.
Recommended separation distance
d=1.2√P
d=1.2√P  80 - 800 MHz
d=1.2√P  800 MHz - 2.5 GHz
where P is the maximum output 
power rating of the transmitter 
lnwatts (W) according to the 
transmitter manufacturer and d is the 
recommended separation distance in 
meters(m)
Field strengths from fi xed RF 
transmitters, as determined by an 
electromagnetic site survey, *ashould 
be less than the compliance level In 
each frequency range*b. Interference 
may occur in the vicinity of equipment 
marked with the following symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range apply.
NOTE 2  These guidelines may not apply in all situations. Electromagnetic propagation Is affected by absorption and 

refl ection from structures, objects and people.
*a  Field strengths from fi xed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 

radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. 
To assess the electromagnetic environment due to fi xed RF transmitters, an electromagnetic site survey should be 
considered. If the measured fi eld strength In the location in which the MODEL MKC-210HD Is used exceeds the 
applicable RF compliance level above, the MODEL MKC-210HD should be observed to verify normal operation. If 
abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the 
MODEL MKC-210HD.

*b Over the frequency range 150 kHz to 80 MHz, fi eld strengths should be less than 3 V/m.
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1. Feature
MKC-210HD is a full-spec HD ultra-compact camera equipped with 1/3 inch CMOS sensor.
MKC-210HD is a high-performance equipment, high-resolution and high-sensitivity and low noise.
MKC-210HD can be clearly photographed the status of the surgery by attached to the surgical microscope.

2. Name and Function of Each Part

2.1. Camera Head

MKC-210HD

1  1/3 C-mount
2  Camera Connector

Side View Rear View
3  Flange focus adjustment ring

4  Flange focus fixation screw 5  Screw hole for fixation

1  1/3  C-mount
 This is the mount for attaching the lens. 
 Allows mounting of various C-mount lens and microscope adapters.

2  Camera Connector
 Connects the camera connector of special camera cables. 
 Be aware that the size of the camera connector differs on the camera head side and CCU side.

3  Flange focus adjustment ring
 Flange focus (distance from the lens mounting surface to the photographed surface) adjustment ring.
 Adjust the flange focus to use the lens focus function under optimal conditions.

4  Flange focus fi xation screw
 Fixes the flange focus adjustment ring.

Caution
Loosen when adjusting the flange focus, and tighten up to fix after adjustment. 
Over-tightening may damage the screw.

5  Screw hole for fi xation
 Screw holes to fix the camera head. Arranged one above the other.

Caution
The screw depth is about 3.0mm.
Using an overly long screw may cause it to come into contact with the flange focus adjustment ring, so
please be careful.
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2.2. Front Panel of Camera Control Unit (CCU) 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

1  POWER button 2  AWB button 3  GAIN button 4  PAINT/AE button

5  BARS button 6  FREEZ button 7  SCENE button 10  MENU button8  Arrow keys

9  FUNCTION/SET button

 
1  POWER button
 This is the power button of the MKC-210HD.

2  AWB button
 To execute Auto White Balance. (See page 14）

3  GAIN button
 Automatic gain control to insure that the output level of the image signal is always constant in relation to the 

brightness of the photographic image. If this function is used effectively, the GAIN button remains lit green. (See 
page 17)

4  PAINT/AE button
 Possible to adjust the AE level and the intensity of red and blue of the image. (See pages 15, 16)

5  BARS button
 Output an internal color bar signal of the camera to a color monitor. Can be used to adjust the color monitor 

brightness, contrast, etc. (See page 18)

6  FREEZ button
 Possible to freeze the screen image. (See page 17)

7  SCENE button
 Used when selecting a scene file. (See page 19)

8  Arrow keys
 Used to select scene files or operate the menu.

9  FUNCTION/SET button
 Press to determine the item you wish to set with the menu displayed. Refer to “Menu Operation”.

10 MENU button
 To display the menu that the user can set as desired on the monitor.
 Select an item you want to set with ⑧ Arrow key and define it with ⑨ FUNCTION/SET button for menu items 

you can set. Refer to “Menu Operation” (Page 20) for further detailed operations.
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2.3. Rear Panel of Camera Control Unit (CCU)

RS-232C

VBS Y/C

DVI

FOOT SW

SYNC

POWER

GENLOCK
1 2

HD SDI

IRIS CAMERA

1 VBS Output 
   Connector

7 DVI-D Output
   Connector

8 HD-SDI Output
   Connector

9 GEN LOCK
   Connector

10 SYNC
　 Connector

11 POWER
    Connector

12 Cable
    Holder

2 S-VIDEO OUT
   Connector

3 RS-232C
   Connector

4 FOOT Switch
   Connector

5 IRIS
   Connector

6 Camera
   Connector

13 Options

1  VBS Output Connector (SD)
 Connects with VBS input monitor, etc. A VIDEO cable (optional) is required for connection.

2  S-VIDEO Output Connector (SD)
 Connects with S-VIDEO input monitor, etc. An S-VIDEO cable (optional) is required for connection.

3  RS-232C Connector
 Connects with PC unit, etc. A cross cable is required for connection.

4  FOOT Switch Connector
 To connect the FOOT SW (option) cable extension from the foot switch.

5  IRIS Connector
 Connects the IRIS cable of a special microscope adapter.

6  Camera Connector
 Connects with camera connector of the special camera cable.
 Be aware that the size of the camera connector differs on the camera head side and CCU side.

7  DVI-D Output Connector
 Connects with DVI-D input monitor, etc. A DVI-D cable (optional) is required for connection.

8  HD-SDI Output Connector (2 Lines)
 Connects with HD-SDI input monitor, etc. The same imege is outputted to 2 lines.
 When connecting use a coaxial cable with a characteristic impedance of 75 Ohms.

9  GEN LOCK Connector
 When using while synchronized with the phase of another system’s image, inputs synchronizing signals from 

the other system. Equivalent to Tri-Level SYNC (HD).

10 SYNC Connector
 When using while synchronized with the phase of another system’s image, outputs synchronizing signals to 

the other system. Equivalent to Tri-Level SYNC (HD).
 * This connector can be used only in synchronization for other MKC-210HD.
   We cannot guarantee the synchronization with our competitor’s product.
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11 POWER Connector
 DC12V input. Connect the accessory AC adapter.

12 Cable Holder
 After passing the power cable through the cable holder, connect to the power connector to prevent the cable 

from falling off during use.

12 Options
 It is possible to mount the two types of optional modules listed below.
 ・IP ENCODER module
 ・DVI module

 

DVI

SD CARD ETHERNET

DVI

DVI

14 ETHERNET15 SD CARD 16 DVI-D Output Connector

14 ETHERNET Connector (RJ45)
 Can be used with Ethernet 10Base-T/100Base-TX. 
 For connection with other devices, please connect a cable of category 5 or higher.

15 SD CARD
 This is the insertion port for the SD card.
 * The SD card is not included in the equipment spec.

16 DVI-D Output Connector
 Connects with DVI-D input monitor,etc. A DVI-D cable (option) is required for connection.

Note  
* Please note we assume no responsibility for warranty when videos are not saved due to any failure of 

this machine and SD card.
* Although in the following cases, saved data may be damaged (lost), please note we assume no 

responsibility for damage and so on caused by data corruption and so on:
 ● When an SD card is used improperly.
 ● When an SD card is not properly inserted into the equipment.
 ● When an SD card is subject to electronic and mechanical shock or force.
 ● When an SD card is removed or power is turned off during access to the SD card.
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3. Operation

3.1. Connection Example

RS-232C

VBS Y/C

DVI

FOOT SW

SYNC

POWER

GENLOCK
1 2

HD SDI

IRIS CAMERA

MKC-2
10HD

DVI-D cable

S-VIDEO cable

HDD/DVD recorder

DVI compatible monitor HD-SDI compatible monitor

Accessory AC 
adapter

Camera cable

Foot Switch
MKC-210HD
Camera Head

MKC-210HD CCU

HD-SDI compatible
Coaxial cable

 * Terminate the output from VIDEO OUT at 75ohms on the receiver side. 
 * For connection of the power supply, be sure to use the accessory AC adapter. 
 * FOOT SW to be connected to this device, it conforms to the IEC60601-1 : 2005
 *  Equipment connected to this unit except FOOTSW that conform to IEC standards that apply to the 

equipment or IEC60601-1:2005
 *  If you are connecting to a device that is in contact with the patient to make the connection in 

accordance with IEC60601-1 : 2005 Annex I Table I.1
 * While connected, it is necessary to fi t the evaluation and IEC60601-1 : 2005 Section 16.

Caution at connection
● Turn off the Power of all the equipment before making connections.
● For the AC adapter for connection, please use the following:

Manufacturer: SINPRO ELECTRONICS
Model name: MPU51-105-P01J

● For exclusive camera head connection goods. Using heads other than that specified may result in failure.
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DVI connector

This connector outputs a digital signal. Connect a DVI cable to this connector.

* Use a DVI cable with a ferrite core at both ends. Contact Ikegami if you are unable to obtain such a cable.

Ferrite core



13

3.2. Electrical Connection
1. Before turning on the power, confi rm that the external devices (camera head, monitor, etc.) are 

correctly connected.

2. Turn on power supply to the monitor and other external equipment.

3. Turn on power supply (POWER switch) of CCU.
● Connect the accessory AC adapter to the power connector on the back of the CCU.
● Even if the power connector on the back of the CCU is connected, the power is turned on automatically.
● When the power goes on, the power button lights green.
● If the Power button light is on and the Power button is pressed, it is possible to turn off the power.
● Immediately after turning on the power, the initialization operation of the CCU and camera head is carried 

out automatically. During this time, an unstable display is displayed on the monitor screen. This does not 
indicate a technical problem.

4. The video image from the camera is output under the same setting condition with the last use.
● When power is turned off in the state of still screen picture, that state will not be held even if power is 

turned on again, and MKC-210HD is set to the normal shooting state.

* When moving the CCU, be sure to turn off the POWER, disconnect the power plug and remove the 
connecting cable between equipment beforehand.

* If the cable comes loose during use, repeat the steps described above.

CAUTION Caution for Camera cable connection and disconnection

Turn off the power of MKC-210HD when you connect or disconnect the camera cable. If the 
CCU is turned on, it may cause the fault of MKC-210HD. 

NOTE: Phenomenon on video image

MKC-210HD may happen following phenomenon on its video image. It is not failure but it is 
because of employing CMOS sensor.

When its sensitivity gain is going up, it may appear high lighting dots. In case under high 
temperature condition, it may be remarkable.

It may appear horizontal stripe pattern or fl icker on a video image under the fl uorescent 
lighting. In this case, please use manual electrical shutter of 1/100 (50Hz area). It will be 
reduce, but please note that it will not disappear at all.

In case of fast moving object on a video image, it may appear distortions. 
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3.3. Setting White Balance
When using MKC-210HD for the fi rst time, or when the light source has been changed, adjust the White 
Balance. The white balance can be adjusted automatically.

<Operation>
1. Shoot a white photographic object on the screen largely, and press AWB button.

● During automatic adjustment, the AWB button is lit green.

  
MKC-210HD

POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

AWB button

● If “AWB” is displayed on the monitor screen and it ends normally, “AWB COMPLETED” is displayed.
 

AWB BUSY

          

AWB COMPLETED

● If “AWB ERROR” is displayed, AWB adjustment was not carried out for the following reasons. Execute 
AWB again.

 • If the image level is too low.
 • If the image level is too high.

2. When automatic adjustment fi nishes, the AWB button extinguishes automatically.
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3.4. Adjustment PAINT
After white balance adjustment it is possible with the MKC-210HD to carry out fi ne adjustment of the red level 
and blue level to adjust the desired tint.

<Operation>
1. Press PAINT/AE button.

● If the paint adjustment function is active, the button is lit green.
● If the button is already lit, it is not necessary to push it.

 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

PAINT/AE button (Lit)

2. Use the arrow keys to adjust the red and blue color.
● Use the ⇧ /⇩ keys to adjust the red color and the ⇦ /⇨ keys to adjust the blue color.

 

1

3
24

Dark red

Light red

Light blue

Dark blue

 

Paint R    0　
Paint B    0　

● The above adjustments are temporary setting changes. They return to the original values if the power is 
turned off.
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3.5. Adjustment AE LEVEL
It is possible with the MKC-210HD to automatically adjust the shutter speed, gain and iris according to the set 
exposure level. By increasing the level when the screen is too dark and decreasing the level when the screen is 
too bright, the screen will be easier to view. This function is active when the GAIN/SHUTTER is in AUTO.

<Operation>
1. Confi rm that the PAINT/AE button is not lit. 

● If it is lit, press the PAINT/AE button to extinguish it.
 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

PAINT/AE button (Extinguished)

2. Use the arrow keys to adjust the AE level.
● Use the ⇧ /⇨ keys to raise the AE level.
● Use the ⇩ /⇦ keys to lower the AE level. 
● The ⇧ and ⇨ keys, as well as the ⇩ and ⇦ keys have the same function.

 

 
1

3
24

AE level is raised.

AE level is lowered.

AE LEV     0　

● The above adjustments are temporary setting changes. They return to the original values if the power is 
turned off.
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3.6. Adjustment Auto Gain
It is possible with the MKC-210HD to automatically adjust the image brightness during photography in relation to 
the brightness of the photographic subject. This makes it possible to constantly maintain an image of the ideal 
brightness. 
The maximum gain value can be set between 3 dB and 18 dB in units of 3 dB.（Refer to Section 4.3. "AE Mode")

<Operation>
1. Press GAIN button.

● The automatic gain adjustment function immediately becomes active.
● If the automatic gain adjustment function is active, the GAIN button is lit green.
 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

GAIN button

2. To stop automatic gain adjustment, press the GAIN button again.
● The GAIN button extinguishes.

White spots may appear on the screen when increasing the gain. This is a 
characteristic of the sensor and does not indicate a technical problem.

3.7. Freeze output

It is possible on the MKC-210HD to temporarily stop moving image output and switch to freeze frame output.

<Operation>
1. Press FREEZ button.

● Immediately switches to freeze frame output.
● During freeze frame output, the FREEZ button is lit green.

 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

FREEZ button

2. To return to moving image output, press the FREEZ button again.
● The FREEZ button extinguishes.
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3.8. Color bar output
It is possible with the MKC-210HD to output a color bar. This is used when adjusting the color monitor 
brightness, contrast, etc.

<Operation>
1. Press BARS button.

● Immediately changes to color bar output.
● During color bar output, the BARS button is lit green.

 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

BARS button

2. To return to camera images, press the BARS button again.
● The BARS button extinguishes.
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3.9. Scene File Selection
By storing settings often used on the MKC-210HD beforehand in a scene fi le, it is possible to read them at any 
time. A maximum of four scene fi les can be stored.

<Readout operation>
1. Press the SCENE button. The button is lit green.

● The arrow key is lit that corresponds to the presently selected scene fi le.
 

MKC-210HD
POWER

AWB GAIN PAINT/AE

FUNCTION/SET

BARS FREEZ SCENE

MENU

1

3
24

SCENE button

2. Use the arrow keys to select the scene fi les.
● The numerical value displayed next to the arrow keys is the number of the scene fi le.
● The arrow key is lit that corresponds to the selected scene fi le.
● The scene fi le setting is immediately refl ected.

 

1

3
24

Scene File 1

Scene File 3

Scene File 4

Scene File 2
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4. Menu Operation
MKC-210HD has various useful and practical functions. The user can select and set these functions on the 
menu. The basic operation is as follows.

4.1. Operation Method
1. Pressing the Menu switch on the front panel of CCU displays a menu on the monitoring screen on which 

various camera functions can be set.

Setup Menu

Video Adjust

AE Mode

Detail

Video Setting

Picture Setting

Scene File

Foot Switch

White Balance

IP-ENC Setting *1

Miscellaneous

Version Information

 *1: The IP-ENC item is only displayed if the optional module is mounted.

2. Use the ⇧ /⇩ keys on the front of the CCU to select the item and then press the SET button to enter the 
submenu screen. The setting values of the setting items can be changed with the ⇦ /⇨ keys.

 
FUNCTION/SET

MENU

1

3
24

Determining the selected items

Selection of items

Changing setting values

Display/non-display of the 
menu screen

* If the Menu button on the front of the CCU is pressed during display of the menu screen, the settings are 
stored and the menu screen stops.
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4.2. Video Adjust
Used to adjust the level of black, red and blue of video picture.

Video Adjust

      Quit

      Pedestal               0

      Video Level            0

      Gain Offset Red        0

      Gain Offset Blue       0

 

Item Setting Value Description

Pedestal Adjusts the black level. Normally not used.

-80 to 80 If the value is increased, the black sections become brighter.

Video Level Adjusts the image signal level. Normally not used.

-64 to 63 Increasing the value produces a bright image. Decreasing the 
value produces a dark image.

Gain Offset Red Adjusts the red level. This is the same function as paint 
adjustment on the front of the CCU.

-128 to 127 Increasing the value causes red to be displayed more vividly.

Gain Offset Blue Adjust the blue level. This is the same function as paint 
adjustment on the front of the CCU.

-128 to 127 Increasing the value causes blue to be displayed more vividly.
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4.3. AE Mode
Used to adjust the electronic shutter and automatic sensitivity setting.

AE Mode

Quit

Shutter Control          AUTO

Manual Shutter           OFF

Auto Shutter Limit       1/4000

AE Level                 0

AE Speed                 MID

Peak Ratio               -128

Area Select              MIDDLE

Gain Control             AUTO

AGC Gain Range           18dB

Normal Gain              -6dB

High Sensitivity         OFF

Line Mix                 OFF

Item Setting Value Description

Shutter Control This item concerns automatic adjustment of the shutter speed.
If the shutter speed is slowed down, the brightness changes 
in relation to the speed. Likewise, in the case of a discharge 
lighting source such as a fl uorescent lamp, the fl icker may 
increase.

AUTO Automatically adjusts to the ideal shutter speed in relation to 
image brightness.

FIX Set to the shutter speed always set by the user. The shutter 
speed is carried out in the item entitled Manual Shutter.

Manual Shutter The shutter speed when the shutter control is in FIX is set 
here. (If set to AUTO, it is ignored). It is usually used in the 
OFF setting.

OFF The shutter speed is set at about 1/60 seconds.

1/100 to 
1/10000

The shutter speed is constantly set to a fi xed value ranging 
between 1/100 sec and 1/10000 sec.

Auto Shutter Limit 1/100 to 
1/4000

If the Shutter Control is on Auto, it is possible to set the upper 
limit of the shutter speed.

AE Level -128 to 127 If the Shutter Control or Gain Control is in AUTO, it is possible 
to make fi ne adjustment of the shutter speed in relation to the 
level set here. If the screen is too dark, the value is increased, 
and if the screen is too bright the value is decreased.

AE Speed Sets the control speed if the Shutter Control or Gain Control is 
in AUTO. 

MID Adjusts to the standard speed.

SLOW Adjusts more slowly than MID.

FAST Adjusts more quickly than MID.
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Item Setting Value Description

Peak Ratio -128 to 127 Possible to adjust the photometry method if the Shutter 
Control or Gain Control is in AUTO. With +127 there is peak 
photometry, and with -128 there is average photometry.
If the background area is almost completely dark and 
the photographic subject is bright, set to the peak light 
measurement side. If the brightness change for the entire 
screen is low, set to the average light measurement side.

Area Select Possible to adjust the extent of the photometry area. Carries 
out automatic adjustment of the shutter and gain, etc. based 
on the image in the frame displayed in the screen.

MID About 40% of the screen center is the photometry area.

WIDE About 60% of the screen center is the photometry area.

FULL The entire screen is the photometry area.

USER.. Allows arbitrary setting of the photometry area. Press the SET 
button to enter the setting screen.
* For details on settings, see Section 5.2 “Manual setting of 

photometry frame”.

NARROW About 10% of the screen center is the photometry area.

Gain Control This item concerns automatic adjustment of gain.
If a dark subject has been photographed, it is possible to 
adjust the brightness.

AUTO The gain is adjusted automatically in relation to the brightness 
of the image input so that the output level constantly remains 
a set value.

FIX Automatic adjustment of gain is not carried out.

AGC Gain Range 3dB to 18dB Setting of maximum gain with Gain Control in AUTO.

Normal Gain -6dB to 6dB Normal gain setting. This setting is always used regardless of 
the Gain Control setting. The higher the value the brighter the 
image, although noise can more readily increase.

High Sensitivity It is used when you want to increase the sensitivity.
Although the sensitivity will increase by a factor of two, 
horizontal resolution will be slightly lower.

ON Carries out increase the sensitivity.

OFF Does not carry out increase the sensitivity.

Line Mix It is used when you want to increase the sensitivity.
Although the sensitivity will increase by a factor of two, vertical 
resolution will be slightly lower.

ON Carries out increase the sensitivity.

OFF Does not carry out increase the sensitivity.
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4.4. Detail
Used to adjust detail enhancement.

Detail

       Quit

       Detail              ON

       Detail Gain         0

       Boost Frequency     16MHz

Item Setting Value Description

Detail Sets the contour enhancement. If contour enhancement is 
carried out, the image is clearer and easier to view. Set it to 
ON usually.

ON Carries out contour enhancement.

OFF Does not carry out contour enhancement.

Detail Gain To adjust the detail enhancement level.

-128 to 127 Increasing the value results in a sharper image.

Boost Frequency Sets the boost frequency for contour enhancement.

2MHz to 
28MHz

The lower the value, the easier it is to carry out contour 
enhancement on the entire screen.
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4.5. Video Setting
Sets the video signal.

Video Setting 

Quit

Format                     59.94Hz

DVI Setting                1080p

Gamma                      ON

Master Gamma               0

Color Saturation           ON

Color Saturation Gain      0

Genlock H Phase            0

Genlock V Phase            0

Item Setting Value Description

Format Selects the output signals HD SDI, DVI, VBS and Y/C. (Not 
possible to change them individually). With VBS output, the 
signal method is also changed.

59.94Hz Output at 59.94 Hz. VBS is output with the NTSC method.

50Hz Output at 50 Hz. VBS is output with the PAL method. 

DVI Setting Select the DVI output signal output format.

1080p Output the progressive signal.

1080i Output the interlace signal.

Gamma If gamma correction is carried out, it is possible to cause the 
caused the dark sections of the image to be displayed brightly. 
Normally this is used in an ON setting.

ON Carries out gamma correction.

OFF Does not carry out gamma correction.

Master Gamma Adjusts the degree of gamma correction. With a setting value 
of 0, the value is γ= 0.45.

-128 to 127 The lower the value, the brighter the dark parts of the image 
become.

Color Saturation Sets the color intensity.

ON Adjusts the intensity of color set with Color Saturation Gain.

OFF Does not adjust the color intensity (normal color image).

Color Saturation 

Gain

Adjusts the color intensity.

-64 to 63 The higher the value, the more intense the color. The lower 
the value the more faded the color. With -64 it is monochrome.

Genlock H Phase -128 to 127 Adjusts the horizontal phase for Genlock input.*1

Genlock V Phase -128 to 127 Adjusts the vertical phase for Genlock input.*1

*1 For details, see Section 5.1 "External synchronization".
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4.6. Picture Setting
 Setting of noise reduction, image inversion, electronic zoom and display position.

Picture Setting 

Quit

DNR                       OFF

H Flip                    OFF

V Flip                    OFF

Digital Zoom              x1.0

Picture Shift H           0

Picture Shift V           0

Item Setting Value Description

DNR Noise reduction function setting.

OFF Noise reduction is not carried out.

- The noise reduction is set in the order of LOW→MID→HIGH. 
With a HIGH setting, for example, the noise is less but the 
remaining image will be prominent in case of a moving 
photographic subject.

H Flip Sets the horizontal inversion of the image.

ON Inverts to a horizontal direction for output.

OFF The horizontal direction becomes the normal rotation output.

V Flip Sets the vertical inversion of the image.

ON Inverts to a vertical direction for output.

OFF The vertical direction becomes the normal rotation output.

Digital Zoom Magnifi cation setting for electronic zoom.

x1.0 to x4.0 The center of the screen is zoomed up in units of 0.1 power.

Picture Shift H -32 to 32 The horizontal display position of the screen is adjusted in 1 
pixel units.

Picture Shift V -8 to 8 The vertical display position of the screen is adjusted in 1 pixel 
units.
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4.7. Scene File
Possible to store and read the setting value information as a scene fi le. Possible to create a maximum of 4 
scene fi les.
* For details on settings, see Section 5.3 "Scene File".

Scene File 

Quit

Scene Number             No.1

Store Scene              READY

Initialize Scene         READY

Item Setting Value Description

Scene Number - Select and read the set scene fi le.

Store Scene - Store the set condition in the scene fi le. 
Select the scene fi le you wish to set and press the SET button.

Initialize Scene - Select the scene fi le you wish to initialize and press the SET 
button. If you select ALL, all scene fi les will be initialized.
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4.8. Foot Switch
Sets the operation when controlling the foot switch.

Foot Switch 

Quit

Foot Switch 1               NONE

Foot Switch 2               NONE

Foot Switch 3               NONE

Foot Switch 4               NONE

Item Setting Value Description

Foot Switch Carries out setting of operations when the foot switch is 
operated. Foot switch operation responds up to 4, allowing 
separate operation settings for each one.

NONE Nothing is carried out, even when the foot switch is operated.

FREEZE Outputs still images. Operate the foot switch again to return to 
moving images.

SCENE FILE Switches the scene fi le selection.

H FLIP Outputs a horizontally inverted image.

V FLIP Outputs a vertically inverted image.

ROTATE Outputs an image inverted 180 degrees.

ZOOM IN Carries out electronic zoom-in.

ZOOM OUT Carries out electronic zoom-out.

SNAPSHOT Inserts still images on SD card with IP encoder (optional).

SHUT CONT. Switch the shutter control (AUTO/FIX).

GAIN CONT. Switch the gain control (AUTO/FIX).

IRIS CONT. Switch the iris control (AUTO/FIX).
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4.9. White Balance
Automatic adjustment of white balance and manual adjustment setting.

White Balance

     Quit

     WB Mode                AWB

     Manual Gain Red        -16

                 Blue       -28

Item Setting Value Description

WB Mode Sets white balance operation.

AWB The white balance is adjusted automatically. Press the SET 
button when this item is selected.

MANUAL Manual adjustment of white balance. Adjustment is carried out 
with Manual Gain Red/Blue.

Manual Gain Red Adjusts the red gain.

-128 to 127 Increasing the value causes red to be displayed more vividly.

Manual Gain Blue Adjusts the blue gain.

-128 to 127 Increasing the value causes blue to be displayed more vividly.
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4.10. IP-ENC Setting (Only valid when optional substrate is mounted)

IP-ENC Setting

Quit

IP Address             ENTER

Encoder Mode           SNAPSHOT

JPEG Quality           A

Item Setting Value Description

IP Address Displays the sub menu.

Encoder Mode Select the image compression method.

SNAPSHOT Compress with JPEG method and record on the SD card.

STREAMING Compress with the H.264 method and distribute the image.

JPEG Quality Sets the image quality if the compression method is set to 
JPEG.

A to E Five steps from A (highest image quality) to E (lowest 
image quality).

IP Address

Quit

IP Address            192.168.001.100

Subnet Mask           255.255.225.000

Item Setting Value Description

IP Address Sets the IP Address.

Subnet Mask Sets the Subnet Mask.
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Do you change the IP Address ?

Cancel            OK

A message appears on the screen asking for confi rmation.
For a scene that can be changed select [OK]. To stop, press [Cancel] and then press the Set button. 
* Only displayed if the IP address is changed.

Note  
● The setting values such as IP address and sub-net mask will vary according to the network environment 

of the customer. Please consult with the network manager. 

Caution at network connection
The IP ENCODER module (option) is for use in connection with the network.
To protect the system from harm specifi c to the network connection, please conduct suffi cient security 
measures under your own responsibility.
Network-specifi c harm includes leak/fl ow of information obtained by this device, disruption due to 
unauthorized access, system halt and so on.
The measures include the following, but please implement suffi cient other measures under your own 
responsibility:
● Do not install in any place where cables can be easily moved/replaced
● Maintain network safety (fi rewall and so on)
● Conduct regular anti-virus checks on all PCs to be connected to the network
● Restrict the number of users connecting via PCs (e.g. password setting)
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4.11. Miscellaneous
Adjustment screen for other functions.

Miscellaneous

Quit

Center Marker              OFF

Menu Lock                  OFF

Cancel                     READY

Initialize(exp.Scene)      READY

Item Setting Value Description

Center Marker Center marker display setting.

ON Center marker is displayed on the screen.

OFF Center marker is not displayed.

Menu Lock Menu lock.

ON Sets a state in which no settings other than Menu Lock 
can be changed. During Menu Lock, a red lock mark is 
displayed in the upper right of the menu screen.

OFF Sets to a state in which all menu item settings can be 
changed.

Cancel Press the [READY]→[START] ⇦ /⇨ keys and then press 
the [SET] button.
The menu items return to the stored state for the former 
time.

Initialize(exp.Scene) - Press the [READY]→[START] ⇦ /⇨ keys and then press 
the [SET] button.
All setting values other than the scene fi le are initialized.



33

4.12. Version Information
To display the software version of this camera.

Version Information

Quit

Model               MKC-210HD

CCU  Firmware       V1.00

CCU  FPGA           V1.00

Head FPGA           V1.00

IP-ENC*1             V1.00

 *1  Only displayed if IP-ENC module is mounted.
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5. Advanced Usage Methods

5.1. External synchronization
If this equipment is used with external synchronization, SYNC is input to the GENLOCK connector on the back 
of the CCU. If SYNC is input to the GENLOCK connector, the camera automatically switches from internal 
synchronization to external synchronization. 
    SYNC input condition: Tri-Level SYNC: 0.6 Vp-p/75 Ohms

5.1.1. Wiring connection example
Prepare two sets of CCU and camera for the MKC-210HD. Connect the SYNC connector of CCU (Master) and 
the GENLOCK connector of CCU (Slave) with the coaxial cable.
 

RS-232C

VBS Y/C

DVI

FOOT SW

SYNC

POWER

GENLOCK
1 2

HD SDI

IRIS CAMERA

RS-232C

VBS Y/C

DVI

FOOT SW

SYNC

POWER

GENLOCK
1 2

HD SDI

IRIS CAMERA

MKC-2
10HD

Camera
(Master)

CCU (Master)

MKC-2
10HD

Camera
(Slave)

Coaxial cable
(Sold separately)

CCU (Slave)

SYNCSYNC Connector ConnectorSYNC Connector

GENLOCK Connector
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5.1.2. Setting
Measure the SYNC output waveforms of the CCU master and slave and adjust the PHASE so that the H/V 
phases match. When adjusting, adjust the slave side (side on which the GENLOCK connector is connected). 
Phase adjustment is not required on the Master side.

Master SYNC

Slave SYNC

Adjust phase

5.2. Manual setting of photometry frame
The Photometry frame can be changed within a random range. By adjusting the photometry frame, automatic 
adjustment of the image to match the usage environment is possible.

5.2.1. Setting
Select [AF Mode]→[Area Select]→[USER] from the menu and press the SET button. The system goes to the 
manual setting screen for photometry frame.

Quit 

Position 

Size 

 

Possible to set the position and size of the photometry frame. When setting is finished, select QUIT and press 
the SET button to finish setting.
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Position Setting
Select Position and press the SET button to adjust the position of the photometry frame. The frame size is not 
changed.

Quit 

Position 

Size 

Movement of frame

Use the ⇧ /⇨ / ⇩ / ⇦ keys to adjust the position. When adjustment is finished, press the SET button to 
complete adjustment.

Size Setting
Select Size and press the SET button to adjust the size of the photometry frame. The upper left corner of the 
frame is fixed. The lower right corner can be moved for adjustment.

Quit 

Position 

Size 

Changing the frame size

Use the ⇧ /⇨ / ⇩ / ⇦ keys to adjust the size of the frame. When adjustment is finished, press the SET button 
to complete adjustment.
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5.3. Scene File
This device allows setting of up to four scene fi les chosen according to photographic conditions. It is also 
possible to return to the condition at the time of shipment from the factory.

5.3.1. Storage of Scene File
The scene file can be created from the menu. Because the present setting is stored in the scene fi le, adjust
beforehand to the setting you wish to store.
Use [Scene File] → [Store Scene] to select No. 1 to No. 4 from the menu and then press the SET button.
When the menu is finished, it will be automatically stored to the scene files being selected. (Refer to Section3.9 
"Scene File").

5.3.2. Initialization of Scene File
Use [Scene File] → [Initial Scene] to select No. 1 to No. 4 from the menu and then press the SET button. The 
selected scene file is immediately initialized.

5.3.3. Setting of Scene File
To use the stored scene file operate the front panel (See page 19) or the foot switch (See page 28) or the menu 
[Scene File] (See page 27) .

5.4. Snapshot (requires optional substrate)
Possible to record still images (JPEG) to SD card. The picture quality setting can be changed with [JPEG 
Quality] from [IP-ENC setting] on the menu.

* The SD card is not included.

5.4.1 SD Card Recording
Possible with the following two operations to record to the SD card.
● Operation from CCU front panel.
 1  Press FUNCTION button.
 2  Press the ⇧ key to store the still image to the SD card.

FUNCTION/SET

MENU

1

3
24

①②

● Operation of foot switch
 For setting, select [SNAPSHOT] with [FOOT Switch] on the menu.

5.4.2. For cards on which recording is fi nished
It is possible to view the recorded images on a PC.

* This device does not include a function for displaying images. 
 A PC is required to view images.
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6. Specifi cation

6.1. Ratings
(1) Lens Mount C-Mount
(2) Image Pickup Device 1/3 type, CMOS sensor (Rolling Shutter)
   Effective Pixels:1920×1080
   Color fi lter.RGB method
(3) Scanning System Progressive Scan
(4) Aspect Ratio H16:V9
(5) External sync Tri-Level SYNC:0.6Vp-p/75 ohms
   Note:The color frame of the down converter output is not locked.
(6) Output Video Signal 
  HD Output HD-SDI (2 Lines) : 0.8Vp-p/ 75 ohms
   DVI  (1 Lines) : 1920×1080P 59.94/50
        1920×1080I 59.94/50
  SD Output SD-VBS (1 Lines) : 1.0Vp-p/ 75ohms
   SD-Y/C (1 Lines) : Y:1.0 Vp-p/ 75 ohms
        C:0.286 Vp-p/ 75ohms
(7) Camera Cable 5m (Standard option) Round connectors, 20 pins
(8) Auto Iris DC Iris, Round Connectors, 4 pins
(9) Input Control Signal RS-232C (1 Line) D-Sub 9pin Male
   FOOTSW (1 Line) D-Sub 9pin Female
(10) Power Requirement DC12V ±10%
(11) Power Consumption Approx. 18W or less
(12) Operating Temperature 0℃ to +40℃
(13) Storage temperature -20℃ to +70℃
(14) Dimensions/Weight Camera Head : W31×H31×D39mm/ 60g or less
   CCU  : W170×H58×D200mm/ 1.1kg or less
(15) Accessories AC adapter, Operation Manual
(16) Option IP ENCODER Module
   DVI Module
   Camera cable (10m)

6.2. Performance
(1) Resolutions Horizontal 900TV Lines (1080I 59.94/50)
(2) S/N Ratio 50 dB (Gamma and Detail OFF)
(3) Sensitivity Standard 2000Lux F7/3200K or more
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6.3. Functions
(1) Gain Control function (AUTO/FIX) Max.18dB
(2) White Balance function (AWB/MANUAL)
(3) Shutter Control function (AUTO/FIX)
(4) IRIS Control (For Shutter IRIS, DC IRIS)
(5) Photometry area variation function
(6) Picture freeze function
(7) Internal color bar
(8) Flip and Turn function (left/right, up/down, left-right/up-down)
(9) Noise reduction function
(10) GENLOCK function
(11) Flange back adjustment function
(12) Down converter function
(13) Electronic zoom function

6.4. Error Message
The error message of connection between Camera Head and CCU

Message Mean
HEAD ERROR The abnormalities in connection between head and CCU 

The error message of Auto White Balance
Message Mean

AWB ERROR AWB has ended signal level of RGB can not be justifi ed within the set time

The error message of Snapshot
Message Mean

Not snapshot mode A mode is not a snapshot.
No SD card An SD card is not recognizable.

SD card is full The capacity of the SD card is full.
Counter is limit The counter of the JPEG fi le arrived at the upper limit.
Data write error An error occurred by the note of data.
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7. External Appearance

7.1. Camera Head
Unit: mm 
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